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Madison Campus Training Manual
for the Journal Entry Tool (JET) for Budgets

Introduction
Overview
High-level View of the Budget Adjustment Process
Making changes to a budget at any level involves these steps:
1. A change to a budget amount occurs after the annual Redbook budget has been
prepared and is locked.
2. The funding source and related coding for the commitment is identified.
3. The transaction data is entered into the system and documentation is completed if
required.
4. The budget adjustment data and documentation is submitted.
5. The budget is verified and monitored.

What is the Journal Entry Tool (JET)?
The Journal Entry Tool (JET) is a desktop application that was developed by Madison Campus
Accounting Services and the Division of Information Technology to allow financial staff
throughout campus to prepare accounting journal files that will load into the PeopleSoft Shared
Financial System (SFS). JET provides security, validations and edits that are not available in
SFS and reduces the complexity of entering accounting journals. It is currently used for
interdepartmental billing, cost transfers, revenue accounting, and budget transfers.

What Business Rules Will Change with the Implementation of JET Budget?
The overall process has not changed, but some small changes will occur.

Account Codes
1. The salary major class codes are standardized within each fund.
In the past, each division chose whether it used detail salary codes or summarized
salary codes. In JET, the Madison Budget Office sets the codes that are used by each
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fund. This is also synchronized with the annual budget (Redbook) load. GPR funds and
certain program revenue and segregated funds will use detail salary codes; most
program revenue and segregated funds will use summarized salary codes.
2. More z-account codes can be used by certain funds.
In the past, the only z-account code that was used was zlump for lump sum budgets.
The same z-account codes that are available in Grants are also available in JET Budget.
However, z-account codes can only be used on certain funds. GPR funds will not use zaccount codes.

Add/Deduct Budgets
1. Divisions will be able to enter add or deduct budgets for certain funds when using zaccounts.

Department IDs
1. Department IDs within the user’s authorization are required for all budget transactions.
The Shared Financial System (SFS) requires a six-digit department ID. In the past,
Legacy transactions that did not have a department were loaded to SFS with 980100.
No division will use a department code that begins with 98.

Forms and Documentation
1. No signatures: The JET enterer is the approver or has the approval documentation.
The only people that are allowed to use JET Budget either have the authority to approve
or have the approval documentation. This eliminates the need for signatures.
2. Paper and separate auxiliary forms are not used.
Documentation is entered within JET which eliminates the need for a separate paper
form; however, one will be available and require signatures if a situation requies it.
Auxiliaries will use the same JET form as other funds.

Transfers
1. Transfers can be entered prior to Redbook load.
The JET Budget type will be active when the other JET types are active. This occurs
with the transition from the old fiscal year to the new fiscal year in mid-July.
2. Transfers are auto-numbered with a division specific prefix.
The budget journal ID is used for the tracking number and will be assigned by JET
Budget within each division-specific prefix. If a number is assigned and is not used for a
journal, a gap will occur in the sequencing if viewed in WISDM data.
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When Do I Use JET Budget?
JET Budget is used to create transactions to load to the standard budget ledger. You can use
JET to create any transfer for departments or projects within your security authorization (usually
your division). You can also use JET to create a transfer to another division; however, you will
need to submit the file to the Madison Budget Office for processing unless you are given
security authorization for that division.

Do Not Use JET Budget for PeopleSoft Grants Budgets
Never use JET Budget to create or change a sponsored project budget. JET journals are
loaded to the standard budget ledger. Sponsored project budgets in PeopleSoft Grants are
loaded to a different ledger with different field requirements. While the Shared Financial System
will take the journal, the information and commitment control within Grants will be inaccurate
because the data is in the wrong ledger. The transaction will be identified on an error report and
will have to be reversed.
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Getting Started with JET Budget
What Do I Need to Use JET Budget?
Before using JET you must have the following items:
1. Authority to approve budget adjustments or the approval documentation.
JET Budget users must have the authority to approve budget adjustments or must
maintain the documentation that shows the adjustment was approved. This means
that most users will be the financial staff in the Dean’s or Director’s Office.
2. Access to the Wisconsin Data Mart (WISDM) web reporting tool.
If you are not currently a WISDM user, fill out a request form and submit it to UW
Madison Accounting Services.
http://www.bussvc.wisc.edu/acct/sfs/wisdm/wisdm2.doc
3. Authorization to use JET Budget.
You must have authorization from the Madison Budget Office to use JET Budget.
Access to other JET transactions such as non-salary cost transfers will not give you
access to budget. Complete the request form that is available on the Madison
Budget Office web site. This will require approval from your Division Financial
Officer.
http://www.mbo.wisc.edu/LAST/
4. A computer that meets the hardware and software requirements for JET.
JET was developed with the Microsoft .NET technology. In order to use JET, a
user’s (Client) PC must meet the following software and hardware requirements:
• Microsoft Windows XP SP2, Windows Server 2003, or Windows Vista (any
edition). [Note: Windows 2000 will not work. This also means other operating
systems do not work, such as the Apple Macintosh.]
• .NET Framework 3.0 or later [Note for Windows Vista users: your Windows
edition already ships with .NET Framework 3.0 and IE 7 - no additional software is
required to run JET.]
•

Internet Explorer 6.0 or later (required only for the initial download)

5. Knowledge of your user id that begins with “msn” and its password.
JET uses the msn user id and password which is also used for Oracle data views.
(Note: your msn id password may not be the same as your net ID password.) If you
have access to WISDM, you can find your msn ID and also reset your password
without knowing what it is currently.
Go to:
Main Menu > My Profile > Change Password
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How Do I Install JET?
The user must install JET on the local or client PC after receiving an authorization email with the
following link:
http://wisdm2.doit.wisc.edu/JournalEntry/Download.aspx
This page will show you how to
1. verify that your PC is set up correctly for JET; and
2. execute the JET download to your desktop.
(Note: The user manual link on this page has information that does not apply to JET Budget
transactions. You will need to refer to this manual instead.)

How Do I Launch JET?
Once the application has downloaded, you will find it loaded to your computer programs.
1. Go to the Windows Start menu (lower left corner)
2. Choose “Programs” or “All Programs”.
3. Choose “UW Division of Information Technology”,
4. Choose “Journal Entry Tool”.
The dialog box to login will appear.
password.

Last Update: 7/6/2009

Use your “msn” user ID (for Oracle data views) and

Page 9 of 34

JET Budget Terminology
What Terms Are Used in JET Budget?
JET Budget uses a few terms that are not in other JET transactions or in its predecessor Legacy
BUDT/EPBT.

Budget Journal ID or “BD#”
This is the Shared Financial System (SFS) accounting journal number that will be used to track
the budget adjustment. The Budget Journal ID is also known as the BD# because the JET
budget journal ID masks start with the letters “BD”. For former Legacy users, this number
replaces the budget transfer number.

Transfer Number or Transfer Group Number
An internal system number used to ensure that an individual transaction within the journal
balances according to budget business rules. While multiple transactions can be included in a
journal, this number matches the related transactions. It also allows the tool to identify the
accounting string for each side of the transfer. The numbers do not remain static. If transfer
group #5 out of 10 transfer groups is deleted, the transfer groups that followed 5 will be
renumbered from 5 through 9.

Budget Journal Option
The two types of budget journals that can be created are (1) transfer and (2) add/deduct.

Transfer Budget Journals
A transfer journal is balanced. Each transfer within the journal as well as the entire journal must
have credits equal debits (i.e. the “from” must equal the “to”) and sum to zero.

Add or Deduct Budget Journals
The add/deduct journals are unbalanced.
journals will show a credit amount.

Add journals will show a debit amount; deduct

Budget Transaction Type
The budget transaction type sets the budget account codes (i.e., major class) that can be used
for the budget journal.

Redbook Budgets
Redbook budgets have the standard major class codes. (See Table: Crosswalk of Legacy
Major Class to SFS Budget Account Codes.) These codes do not begin with “z” and are used
for budget reports (such as the Budget Control Report and the Major Class Report).
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Lump Sum Budgets
Lump sum budgets have account codes that begin with “z” and can only be used with projects.
While zlump has been the only account code used prior to JET Budget, other z account codes
are now available. They allow project tracking for management purposes without changing the
annual Redbook budget amounts. The budgets in lump sum codes are excluded from Madison
Budget Office reports.

What Are the Security Authorization Types?
JET Budget has two types of security authorizations: (1) restricted and (2) unrestricted.

Restricted (Unit-wide)
The restricted authorization is intended for those who need to perform transactions at a central
campus level. It allows the following:
•

Submitting transactions for any valid Madison fund

•

Use and transfers of lump sum budgets on any fund

•

Transfers between program and account codes on any fund

•

Use of Budget Option Type Add/Deduct on any fund

Unrestricted (Division)
Divisions or central campus financial administration needing less flexibility in transactions use
the unrestricted authorization. It allows the following:
•

Transfers between program codes and account codes in a limited number of funds

•

Submitting transactions for a limited number of funds

•

Use of Budget Option Type Add/Deduct on a limited number of fund

•

Submitting transactions to SFS within authorized (usually division) coding

What Are the Major Class Codes (SFS Budget Account Codes)?
Major class codes are large categories of expenses that are used to track state agency budgets.
The Shared Financial System (SFS) refers to them as budget account codes. For GPR funds
and certain program revenue and segregated funds, the salary codes are more detailed (e.g.,
unclassified salaries, classified salaries, graduate assistants, limited term employees (LTEs),
student salaries). For most program revenue and segregated funds, the salary codes are
summarized to two categories: (1) permanent salaries and (2) limited term employee and
student salaries. All other categories are the same for all funds: fringe benefits, supplies &
expenses, capital expenses, sales credits, special purpose, and financial aid.
Table: Crosswalk of Legacy Major Class to SFS Budget Account Codes below provides the list
of SFS budget account codes, the type of funds to which they apply, and the equivalent major
class in Legacy BUDT/EPBT.
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Table: Crosswalk of Legacy Major Class to SFS Budget Account Codes

Legacy Legacy
Major Definition
Class

SFS
Budget
Account
Code

SFS Definition

Funds Use
Detail Salaries

Funds Use
Summarized Salaries

All GPR funds
plus 127, 130,
165, 166, 190,
528, 530, 533

All PR and SEG
funds excluding 127,
130, 165, 166, 190,
528, 530, 533

10 or
10RS

Salaries

SALPRM

Salary Permanent

10CL

Classified
Salaries

SALCLA

Classified Salaries

X

10FA

Faculty and
Academic
Staff Salaries

SALUCL

Unclassified Salary

X

10GA

Grad
Assistants

GRDAST

Grad Assistants

X

10LT

Limited Term
Employee
(LTE)
Salaries

LTE1

LTE Salary

X

10LS

Limited Term
Employee
(LTE) and
Student
Salaries

LTESTU

LTE/Student
(salaries)

10ST

Student
Salaries

STUDNT

Student Salary

X

19

Fringe
Benefits

FRING1

Fringe Benefits

X

X

20

Supplies and
Services

SPEXP1

Supplies &
Expenses

X

X

30

Sales Credits

SALCR1

Total Sales Credits

X

X

40

Capital

CAPEX1

Capital Expense
Budget

X

X

55

Special
Purpose

SPPUR1

Special
Purpose/Debt
Service

X

X

57

Financial
Assistance

FNAID1

Financial Aid
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X

X

X

X

Beginning to Create Any JET Budget Journal
You must be authorized to the JET Budgets type to create budget adjustments.

How Do I Set Up the JET Budget Journal?
File > New Journal
To start a journal, choose file > new journal or the “new journal” icon (white paper) in the left
hand corner. A window will appear with all of your authorized JET journal types. Highlight
“budgets” if it is not already highlighted.

This window helps you create your journal header. It contains the following fields:

Business Unit (Default)
This field defaults to “UWMSN” for Madison campus.

Journal Date (Default)
The journal date will default to today’s date or July 1st for the 13th accounting period. It will
change every time you open the file until you have submitted the journal.

Fiscal Year (Default)
The fiscal year defaults to the current fiscal year. It will not change over to the new fiscal year
until JET is set to run for the next fiscal year. This allows final year-end processing in July.
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Description (Required)
As with other JET journals, enter your name and phone number in the field. You have up to 30
characters if you want to add other information. If you need to update the information later, you
can choose “Journal > Properties” from the menu bar.
This field is visible in WISDM if you drill into the journal. Other description fields will be available
for each line of the journal and are visible and searchable without having to view the journal.

Trans Ref (Not Used)
The trans ref field does not appear in budget journals.
After completing this information, click “OK”. This will launch the Budget Journal Wizard.

Using the Budget Journal Wizard
The budget journal wizard sets the criteria for the budget journal template. It consists of four
screens:
(1) Budget Transfer Option, (2) Budget Transaction Type, (3) Supporting
Documentation, and (4) Review Selection.

Budget Transfer Options (Required)
The wizard will ask you what type of budget journal you want to create: (1) Transfer and (2)
Add/Deduct.
Transfer Budget Journals
A transfer journal is balanced. Each transfer within the journal as well as the entire
journal must have credits equal to debits (i.e. the “from” must equal the “to”) and sum to
zero.
Add or Deduct Budget Journals
The add/deduct journals are unbalanced. Add journals will show a debit amount; deduct
journals will show a credit amount. These journals are only allowed with the following
funds: 133, 135, 138, 142, 143, 144, 233, 533.
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Budget Transaction Type (Required)
After you choose the budget transfer option, the budget journal wizard will ask you what type of
budget transaction to use for the journal: (1) Redbook Budgets or (2) Lump bum budgets.

Redbook Budgets
Redbook budgets have the standard major class codes. Major class summarizes types
of expenses into categories: types of salaries, fringe benefits, supplies & expenses,
capital expense, sales credits, special purpose, financial assistance. (See Table:
Crosswalk of Legacy Major Class to SFS Budget Account Codes.) These codes do not
begin with “z” and are used for budget reports (such as the Budget Control Report and
the Major Class Report).
Lump Sum Budgets
Lump sum budgets have account codes that begin with “z” and can only be used with
projects. While zlump has been the only account code used prior to JET Budget, other z
account codes are now available. They allow project tracking for management purposes
without changing the annual Redbook budget amounts. The budgets in lump sum codes
are excluded from Madison Budget Office reports.
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When you have completed the information, click “Next”.

Supporting Documentation (Required)
The third screen provides the fields that are used to enter the justification for the budget
adjustment. The information can be changed or updated at another time by choosing “Tools >
Modify Journal Documentation”. See How Do I Update the Budget Documentation?
Transfer Reason From (Required)
This field provides the justification for the source of the transfer. If you do not want to
add this information at this point, enter a space or character to continue on. You can
update the information at another time. The field allows 250 characters.
Transfer Reason To (Required)
This field provides the justification for moving the funding. If you do not want to add this
information at this point, enter a space or character to continue on. You can update the
information at another time. The field allows 250 characters.
List Names of Others to Notify (Optional)
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Use this space to identify others who should receive a copy of the transfer. They will
receive an Adobe PDF file of the budget documentation and journal. The field allows 250
characters.
Additional Comments (Optional)
Use this space to add any additional information. The field allows 250 characters.
When you have completed the information, click “Next”.

Review Selection (Required)
The final screen summarizes the criteria for the budget journal. It will include the budget
transfer option, the budget transaction type, the scenario code (a pre-set required SFS field),
the transaction authorization level (“unrestricted” for divisions), and the journal mask.
If everything is correct, click “Finish”; otherwise, click “Previous” to go back to the screen where
changes need to be made.
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When and How Do I Enter a Tracking Number?
The Budget Journal ID or BD# is used to track the budget adjustment. Once the budget journal
wizard is finished, the budget journal ID can be assigned at any time or you can allow the
system to assign it when submitting the journal.

Assign BD# Link or Journal > Assign BD#
To assign the budget journal ID, choose the “Assign BD#” link in the journal tasks pane or
Journal > Assign BD# from the menu bar. This can be done at any point before submitting the
journal to SFS.
If you do not assign a BD#, a budget journal ID will be assigned as part of the “Submit to SFS”
processing. If you have an interdivision transfer which must be processed by central campus
and you assign a BD#, that journal ID will remain on the file when submitted by central campus.
If you do not assign a BD#, the budget transfer will have a central campus journal ID such as
BDMB00001 which is a Madison Budget Office tracking number.

Â TIP:

USE YOUR OWN BD# FOR INTERDIVISION TRANSFERS: You will find it easier to
find and track your budget journals if you assign your own budget journal ID. In
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WISDM, go to the main page to the processing status box. Click on the link “GL
Star”. Click the journal ID column to sort the journals alphabetically. Look for journal
IDs that start with your journal mask (such as BDLS for the College of Letters and
Science).
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Entering a JET Budget Journal
To enter a transfer budget journal, you will need to use the Budget Transfer Tool. To create an
add/deduct budget journal, you will directly enter data in a grid as you would with other JET
journals. For either a transfer or an add/deduct, you may also import a text or Excel file.

What Is the Budget Transfer Tool?
The budget transfer tool is a data entry screen that ensures that the transfer balances and the
associated lines are not accidentally deleted.

How Do I Use the Budget Transfer Tool?
Add Transfer Link or Journal > Add Transfer
To launch the budget transfer tool, either choose “Add Transfer” under the Journal Tasks pane
on the right hand side of the screen or choose “Journal > Add Transfer” from the menu bar at
the top of the screen.
The tool consists of two tabs: (1) Transfer and (2) Generated Lines.
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Transfer Tab
The transfer tab is divided into two sections: one for the “from” coding and the other for
the “two” coding. The screen will only accept one accounting string for “to”. The
account codes will list those that are available for either the redbook budget or lump sum
budget depending on which you chose for the budget template. You can either select
from the drop down list or start to type the first few letters of the account code.

Â TIP:

USING THE CORRECT ACCOUNT CODES FOR THE FUND: The redbook
account codes will show all salary codes for all funds. If you choose the
wrong account code, you will receive an error message on submitting the
journal. Refer to Table: Crosswalk of Legacy Major Class to SFS Budget
Account Codes if you need to look up the correct account code.

Generate Lines Tab
This tab will automatically generate the “from” and “to” accounting string in the
description. If you would prefer to have a different description, you can type over this
string and enter up to 30 characters. You can also enter up to 10 characters in the
Jrnl_Ln_Ref field and it will display in WISDM (if you choose to include that field in your
display. (Note: The tool will change the description back to the default accounting string
label if you go back into the tool and select “update transfer”, but the Jrnl_Ln_Ref will
remain.)

When you have finished entering the data, click “Add Transfer” on the bottom right corner of the
transfer tab. You will see your data in JET’s main grid area behind the budget transfer tool
window. Click “Close” in the lower left corner if you do not want to add any additional transfers.

Modify Transfers Link or Journal > Modify Transfer
To modify a transfer, either choose “Modify Transfer” under the Journal Tasks pane on the right
hand side of the screen or choose “Journal > Modify Transfer” from the menu bar at the top of
the screen.
Finding a Transfer Group among Several
If you have several transfers in the journal and need to modify one, look at the transfer
number on the right hand side of the grid. When you enter the budget transfer tool,
enter that number in the transfer number box on the tool bar and press enter. The
budget transfer tool will then take you to that transfer group section.
Deleting a Transfer Group
To delete a transfer group, click on the red X in the budget transfer tool bar at the top of
the window. JET will renumber the transfer group numbers to eliminate any gap in the
sequence.
Deleting a From Source Line
To delete a line in the “from” section, click on the box with the arrow head at the
beginning of the line to highlight it. Press the delete key.
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How Do I Enter an Add or Deduct Budget?
As with other types of JET journals, add or deduct journals use JET’s direct entry grid. The
budget transfer tool is not used and there is no transfer group number. The accounting string
can be entered directly. The budget account codes will have a drop down box for the
appropriate codes. Deductions use a negative number (credit). Adds use a positive number
(debit).

How Do I Import Data into a JET Budget Journal?
JET Budget can import two types of files: (1) text file (.txt) or (2) an Excel file (.xls). The Excel
file cannot use the most recent version of Excel (.xlsx) at this time and must be saved to a lower
version.

Preparing a File
Use the file format below to import for either budget transfers or add/deduct budget journals.
The file begins with the characters “BUDT” on the first line to specify what type of file it is. In
Excel, this will be cell A1. The second row in an Excel file is used for label descriptions and is
never imported. The field order is listed below. Refer to the Table: Text File Record Layout for
field length and detailed explanations.
Transfer
Num.

Department

Fund

Program

Project

Account

Amount

Description (30)

Jnl_Ln_Ref
(10)

For budget transfers, transactions are grouped by transfer number – a unique integer assigned
to each transfer group. Each individual transfer must balance to 0.00. Each transfer must also
have only one “To” side of the transfer (a positive debit amount). You must enter the transfer
group number in the file. JET will not import the file for a transfer without them. Note that for
adds or deducts, you do not enter a transfer number.

Â TIP:

ENTERING IMPORT DATA FOR A TRANSFER BUDGET: Enter one side of the
transfer first with the transfer numbers. Copy that data to create the other side.
Reverse the sign for the amount and update any coding. Note: On import, JET will
reorder the data so each transfer group has its matching lines together with the
”from” (credits) first and then the “to” (debits).
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Table: Text File Record Layout
Data
Element
Transfer
Number

Start
Position
0

Department
Fund
Program

Length Required
5

No

5
11
14

6
3
1

Yes
Yes
Yes

Project

17

7

No

Account

24

10

Yes

Amount

34

16

Yes

Description

50

30

No

Journal Line
Reference

80

10

No
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Explanation/Example
A number representing the transaction line’s
transfer series number. This number can be left
or right justified and must be an integer between
0 and 99999. A BUDT file can import up to
100,000 transfers in a single file. This is not
required and can be left as blank spaces if
importing for budget add/deduct.
6-digit department code, e.g. “030500”.
3-digit fund code, e.g. "133"
1-digit program code, e.g. “2”. Do not use
program code R -- it will be rejected at editing
time.
7-digit project code, e.g. “133FJ21”, or
“133fj21”. Leave the spaces blank if Project ID
is not used. If making a journal containing
lump sum accounts (Z-accounts), this field will
be required at editing time but is not required at
import time.
Up to 10 character account code (e.g.
“ZLUMP”). Space fill to the right for accounts
less than 10 characters.
May have up to 2 digits in the decimal portion
(more than two will be rounded). Use leading
minus sign “-“ for a credit amount (transfer
from) and no sign is necessary for debit amounts
(transfer to). Field should be left-justified, space
filled to the right. No need to zero fill amounts.
Extraneous non-numeric characters (other than
whitespace) will result in a file import error.
Transaction line description. It displays in
WISDM drill down and transaction details.
Line description is indexed in WISDM for
searches. By convention, the line descriptions
for transfers have the form of “Fm [fund]-[dept][prog]-[acct]” for the to side and the form of “To
[fund]-[dept]-[prog]-[acct]” for the from side.
This labeling convention is not enforced but is
encouraged to use.
You can put whatever data you wish here. It
displays in WISDM drill down and transaction
details and is searchable. Left-Justify, space fill
to the right.
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Tips on Excel Imports
1. The import sheet must be the first one in the file. Other sheets such as pivot tables can
follow.
2. Do not put extraneous data after the last row. It will either import or create an error and
prevent import.
3. You can use the columns to the right of JRNL_LN_REF for extraneous information. It
will not affect the import.
4. Know your totals before importing and check the debits and credits after importing.
a. JET will not import data errors including transfer lines that do not have a match.
b. JET will use the “from” (credit) amount on the transfer group lines that do not
balance.
5. Format department IDs with leading 0 as text (e.g., 030500).
6. Capitalize account codes.

How Do I Update the Budget Documentation?
Budget documentation is required for interdivision transfers. The policy for intra-division budget
journals (transfer or add/deduct) is determined by the division.

Tools > Modify Documentation
Documentation can be updated even after submission, but needs to be completed before
submission for an interdivision transfer. However, JET does not prevent submission for lack of
documentation. To update the information, choose “Tools > Modify Documentation” in the
menu bar and click “OK” after revising the data.

How and When Do I Save the File?
File > Save As
A file can be saved JET at any point after one transfer group is entered. Choose File > Save
As. If you never save the file, JET Budget will prompt you to save at the time you “Submit to
SFS”

Last Update: 7/6/2009
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Validating and Submitting a JET Budget Journal
JET allows you to verify your journal against various requirements before submitting the journal.
The edits for funds, programs, departments, and projects are updated overnight and will not
have changes for the current day.

What Validations Occur in JET Budget?
There are several types of validations. Some occur when you edit the journal before submitting
while others occur when the journal is submitted.
1. Org Edit (formerly Legacy Master File)
Org Edit verifies that the fund and program are valid for the department. This
information can be set up or updated by submitting a Department ID Action Request
Form to Accounting Services.
This validation occurs when you edit the journal line or the entire journal.
http://www.bussvc.wisc.edu/acct/forms.html#DepartmentIDActionRequestForm
2. Madison Project Edits
The Madison Project Edits are setup in Project Lite (SFS Project Costing) for the project.
These include the fund, departments and programs that the project can use.

Â TIP:

CONFLICTS BETWEEN ORG EDITS AND MADISON PROJECT EDITS:
When the project edits are set up in Project Lite, the fund and program for the
department are not verified. It is possible to set up a project with a
department that is not valid for the fund and program. If your project edits are
valid, you may need to submit a Department ID Action Request Form to
Accounting Services if you receive a validation error.

This validation occurs when you edit the journal line or the entire journal.
3. Budget Validations
The Budget Validations verify budget business rules (such as no transfers between
funds, detail salary budget codes must be used on GPR funds).
This validation occurs when you edit the entire journal or when the journal is submitted.
4. Authorization Validations
Authorization ensures that you are working with the correct department data and at the
correct level of authority (unrestricted versus restricted).
This validation occurs when you edit the journal line, edit the entire journal or when the
journal is submitted.

Last Update: 7/6/2009
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5. Journal Validations
Journal validations ensure that the data meets the standards to submit to SFS such as
the dollar amount on one line of the journal cannot be zero.
This validation can occur at various times in creating a transfer such when importing a
file, editing the journal, and submitting the journal.
6. SFS Combo Edits (not seen by user)
This validation verifies that the journal has the correct scenario code as required by SFS.

How Do I Validate a Budget Journal?
Validations can be performed on budget journals either by line or on the entire journal. Some
budget rule validations will only occur when the journal is submitted. For help with error
messages, see Appendix: Error Messages Used in JET Budget.

Edit Current Line Link or Journal > Edit Current Line
An individual line in the journal can be checked by having the cursor on that line and choosing
the “Edit Current Line” link in the journal tasks pane or Journal > Edit Current Line in the menu
bar. The types of errors that will be identified are missing data, using a department outside of
your authorization, an invalid fund and/or program for the department (org edit), and an invalid
fund/program/department for the project (Madison Project Edits).

Edit Journal Link or Journal > Edit Journal
A journal can be checked by choosing the “Edit Journal” link in the journal tasks pane or Journal
> Edit Journal in the menu bar. The types of errors that will be identified are missing data, using
departments outside of your authorization, some budget rule violations such as transferring
between funds, invalid funds and/or programs for the department (org edit), and invalid
fund/program/department for the projects (Madison Project Edits),

Submit to SFS Link or Journal > Submit to SFS
Journal edits will run when you choose the “Submit to SFS” link or Journal > Submit to SFS. It
is recommended that you run the edits before submitting the journal. Besides the errors that are
identified as part of editing the journal, submitting will identify errors for budget business rules
(such as using the wrong salary budget account code for a fund).

What Happens When I Submit a Budget Journal?
If the budget journal accounting strings are within your authorization (usually your division), the
file will be submitted to SFS when you choose the “Submit to SFS” link. If it is not within your
authorization, you must send the .jet file and any supporting documentation to
mbo@vc.wisc.edu for further processing.

Submit to SFS Link
Last Update: 7/6/2009

Page 26 of 34

The submit to SFS link will do the following:
1. Run the validations. Some budget business rules will not be checked prior to this.
2. Assign a budget journal ID if one has not already been assigned.
3. Put the file in the queue for the overnight load to the Shared Financial System.
4. Save your file to the place you have previously saved it; or Prompt you to save the file.
All JET files have a .jet extension.

How Do I Check the Status of a Budget Journal?
WISDM GL Star Link
After a journal is submitted, you can see whether it has been posted in the “Database Status”
section of the WISDM main screen. Click on the “GL Star” link. You will see a month calendar
with hyperlinks on certain dates. Click on the date that is the day after you submitted the journal
to SFS. This will list the journals. Click on the column heading “GL Jrnl ID” to sort by journal
and scroll down to your budget journal ID prefix (e.g., BDLS for College of Letters and Science).

Journal > Check Status
You may also check the status of the budget journal in JET. Choose Journal > Check Status
from the menu bar. Enter the journal ID and the date of the journal.
Examples of journal status messages:
• The specified journal has not been created yet.
• The specified journal is pending and ready for the posting process.
• The specified journal has posted to SFS and has been extracted to WISDM as well.

How Do I Export a Budget Journal?
File > Export > Excel File
When you export a budget journal, the file will be in the format that is required for an import into
JET Budget. The spreadsheet will not include the budget journal id, but the file name will
default to the id unless you save it as another name.
To export a budget journal, choose:
1. File – Export – Excel File from the menu bar
2. Verify the file name and directory
3. Click “Save”

Last Update: 7/6/2009
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Where Do I Find More Information or Help?
Reference information about JET Budgets is available on the Madison Budget Office website at
the following link:
http://www.mbo.wisc.edu/LAST/
You may also contact the budget office staff or email mbo@vc.wisc.edu.
If you have general questions about JET or the other JET applications, contact
sfsmsn@bussvc.wisc.edu.

Last Update: 7/6/2009
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Appendix: Division Budget Journal ID Mask
Budget Journals will begin with BD and then have the following letters (e.g., BDMB for Madison
Budget Office): One journal mask is assigned to each user. It will match the primary division
number but not each division code. For example, the School of Medicine and Public Health
uses division/department 53, 55 and 9353. Any budget transaction will have a journal ID that
begins BDMD.
Division Journal
Mask
AC
AG
AU
BE
BU
CS
DS
ED
EM
EN
ES
EX
FM
GL
GS
HE
HS
HY
IA
IS
IT
LA
LS
MB
MD
NU
OE
PD
PH
RS
SB
SP
UA
UH
VL
VM
WU
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Division Name
Accounting - Campuswide
Agriculture & Life Science
Auxiliary Operations
Cross-college Biology Educ
Business Services
Continuing Studies (intradiv)
Dean of Students
Education
Enrollment Management
Engineering
Inst for Environmental Studies
Continuing Studies (campus)
Facilities Planning & Mgmt
General Library
Graduate School
School of Human Ecology
University Health Services
State Lab of Hygiene
Intercollegiate Athletics
International Studies
Information Technology
Law School
College of Letters & Sciences
Madison Budget Office
Medicine & Public Health
Nursing
Officer Education
University Police Department
Pharmacy
Recreational Sports
School of Business
Research and Sponsored Programs
University Admin - div 01 & 02
University Housing
Veterinary Diagnostic Lab
Veterinary Medicine
Wisconsin Union
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Division
DeptID
Unit-wide
07
Unit-wide
37
03
93
04
17
05
19
40
Unit-wide
71
49
34
27
57
52
42
10
06
45
48
Unit-wide
53
54
63
77
56
80
12
Unit-wide
01, 02
85
88
87
96

Appendix: Error Messages Used in JET Budgets
Error Message
Account code not allowed
with the fund.[Rule 8 violation]

Validation
Source
Budgets
Validation

Account code not allowed
with the fund.[Rule 9 violation]

Budgets
Validation

Account required

Edits

Add/deduct not allowed with
this fund [Rule 4 violation]

Budgets
Validation

DeptID not valid.

Edits

DeptID required

Edits

Failed to submit journal. You
have attempted to submit a
journal that appears to
already have been submitted.

Pop-up
message on
submit to
SFS

Fund code not allowed.

Edits

Fund code not valid

Edits

Last Update: 7/6/2009

Meaning

How to address it

Fund requires detail
salary account
codes
Requires
summarized salary
account codes
The account code
field is blank and
must be entered to
complete the
transaction.
Adds and deducts
are limited to the
following funds:
133, 135, 138, 142,
143, 144, 233, 533
The department
does not exist or you
have keyed in too
few digits.

Use SALUCL, SALCLA,
GRDAST, LTE1, STUDNT

The deptID field is
blank and must be
entered to complete
the transaction.
JET has a
mathematical
formula that
calculates a number
for each journal
based on the
entered data. While
not foolproof, there
is a high probability
that this journal has
already been
submitted.
This fund is either
not valid for Madison
campus or cannot be
used for a budget
transaction.
This fund does not
exist.
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Use SALPRM, LTESTU

Enter a valid account code.

Only create an add or deduct
budget with the following funds:
133, 135, 138, 142, 143, 144,
233, 533
(1) Check for a data entry error.
(2) Check WISDM Funding
Validation
(3) Use JET Chart of Accounts
if department will have less than
100 possible combinations.
Enter a valid deptID (six-digit
organization code).

(1) Verify that the journal has
not already been entered.
(2) Re-order the lines if the
journal needs to be submitted
and happens to be extremely
similar to a previously submitted
journal.

Verify what the correct fund
code is. Contact
mbo@vc.wisc.edu if you think
the fund code is valid.
Verify what the correct fund
code is. Contact
mbo@vc.wisc.edu if you think
the fund code is valid.

Error Message
Fund required

Validation
Source
Edits

Meaning

How to address it
Enter a valid fund.

(1) Verify the appropriate
programs for the project.
(2) If the program is valid,
update the Madison edits in
Project Lite or send an updated
non-sponsored projects request
form to
sfssetup@bussvc.wisc.edu.
http://www.bussvc.wisc.edu/acct
/nonsponsored/index.html

Import Error: Bad transfer
number on line x. A transfer
number is required for all lines
in the import file.

Pop-up
message on
import.

Import Error: The process
cannot access the file
'XXXXXXXX' because it is
being used by another
process.
Import Error: Zero dollar
amount not allowed (line XX).
Please fix the source file and
try again.

Pop-up
message on
import.

MSN(E03) DeptID invalid for
fund/project ID

Project Lite
Madison
Edits (SFS
Project
Costing)

The fund field is
blank and must be
entered to complete
the transaction.
Any import file for a
budget transfer (not
add/deduct) must
include a transfer
group number on
each line.
The file that you are
trying to import is
open in another
application (such as
Excel).
Accounting strings
that have $0 for the
amount cannot be
loaded into SFS.
JET Budgets checks
for this to prevent a
journal upload
problem in SFS.
The Department ID
that you are
attempting to use
has not been set up
for this project.

MSN(E04) Program invalid for
fund/project ID

Project Lite
Madison
Edits (SFS
Project
Costing)

The program that
you are attempting
to use has not been
set up for this
project.

Only z-account codes are
allowed.[Rule 5 violation]

Budgets
Validation

Last Update: 7/6/2009

Pop-up
message on
import.
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Enter transfer group numbers on
each line of the import file.

Close the file in the other
application.

Delete any lines that have $0 for
the amount. Make sure your
transfer groups still have two
sides ("from" and "to").

(1) Verify the appropriate coding
for the project.
(2) If the department is valid,
update the Madison edits in
Project Lite if you have the
authority to do so; or send an
updated non-sponsored projects
request form to
sfssetup@bussvc.wisc.edu.
http://www.bussvc.wisc.edu/acct
/nonsponsored/index.html

Error Message

Validation
Source

Meaning

How to address it

ORGEDIT: Fund-Program
invalid for Dept.

Edits

The department
entered into the
funding field is not
able to use
combination of
values entered into
the Fund and
Program fields.
Department IDs are
set up to specific
funds and specific
program codes. For
example, dept.
036500 does not
have 144 funds,
which also cannot be
used with program 1.
The reasons for the
transfer are set as
required fields as of
7/7/2009.
This program code
represents revenue
and is not valid for
budgets.
The program code
must be one of the
following: 0, 1, 2, 3,
4, 5, 6, 7, 8, 9, F

This information can be set up or
updated by submitting a
Department ID Action Request
Form to Accounting Services.

Please enter the from and to
reasons

JET Budgets
Pop-up
message

Program Code R not allowed.

Edits

Program not valid

Edits

Program required

Edits

Project is inactive.

Edits

Project ID is required

Edits

Last Update: 7/6/2009

The program field is
blank and must be
entered to complete
the transaction.
The project status is
closed or closedarchive.

If you are entering a
lump sum budget,
you must use a
project code.
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http://www.bussvc.wisc.edu/acct
/forms.html#DepartmentIDAction
RequestForm

If you do not want to enter data,
enter a space or any character.

Use a program code (formerly
legacy activity code) that
represents a function. See
XXXXXXXXXXX
Enter a valid program code: 0,
1, 2, 3, 4, 5, 6, 7, 8, 9, F. Note:
The program code must be valid
with the fund, department, and
project or you will generate a
different error.
Enter a valid program code.

(1) Verify that you are using the
correct project.
(2) Update the project status in
Project Lite if you have the
authority to do so.
Either:
(1) Enter a valid project code; or
(2) Create a Redbook budget
transaction type instead.

Error Message

Validation
Source

Meaning

How to address it

Today’s date (jrnl date) is
outside of project dates.

Edits

Today's date (which
is used for the
journal) is not within
the project's
budgetary control
date. Note: The
budgetary control
date is not
necessarily the
same as the project
date.

Transfer between account
codes not allowed.[Rule 3
violation]

Budgets
Validation

Transfer between funds not
allowed.

Budgets
Validation

The fund that you
are using does not
allow transfers
between account
codes at the division
level.
Transfers cannot
occur between
funds.

Options:
(1) If you have direct access to
Project Lite, update the
budgetary control dates. If you
do not have direct access to
Project Lite, submit a request to
the appropriate central campus
administrator who can update
the dates for you.
(2) If the project date has not
started yet, wait until the start
date to submit the journal.
(3) Temporarily change the
budgetary control date, submit
the journal, and then change the
budgetary control date back
again. (The risk is that other
transactions can go through
during the time the date is
changed.)
(1) Verify your program code.
(2) Send the file to
mbo@vc.wisc.edu for further
processing.

Transfer between program
codes not allowed.[Rule 2
violation]

Budgets
Validation

You are not authorized for
department ‘xxxxxx’.

Authorization
Validation

Zero dollar amount is not
allowed.

Budgets
Validation

Last Update: 7/6/2009

The fund that you
are using does not
allow transfers
between program
codes at the division
level.
Your JET Budget
security does not
include this
department.

You did not enter a
dollar amount on
that line or you
entered $0 which is
not allowed.
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(1) Verify your fund code.
(2) Contact the Madison Budget
Office to determine how to
handle the situation if you still
believe you need to transfer
between funds.
(1) Verify the program code.
(2) Send the file to
mbo@vc.wisc.edu for further
processing.

(1) Verify that you are using the
correct department ID.
(2) If you need to use an
accounting string that is outside
of your department authorization
(such as a transfer to another
division), send the transfer to
mbo@vc.wisc.edu for further
processing.
Enter the correct dollar amount
or delete the line. In the budget
transfer tool, highlight the line to
delete it.
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